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5. Working with SR1

Demo Mode
The SR1 demo runs automatically and demonstrates how the program works by showing a sample
calculation. The Demo is started by using the menu item "Help" followed by the menu item "Demo". Always
click OK or Close to get the next step.

Program Start
Start the program at Start->Programs->HEXAGON->SR1 .
If password option is set, you are asked to enter your password. All names of existing subfolders are valid
passwords. The user directory "TRAIN" is automatically created by setup program.

SR1 will accept capital letters and small letters equally. If there has no User Directory been created for you
yet, FED5 will be terminated. Thus your files are protected from access of unauthorized users. See under
Chapter 3 (Installation) in such a case and create the respective user folders.
At "File->Settings" you can configure the program not to show license window and ask for password at
program start.

5.1. Main Menu

Title              Sub-title                           Function
File      New      Carry out new calculation A-Z
File      Open                Load previous calculation
File      Open  (Table)           Load previous calculations from preview table
File      Save                Save calculation to file
File      Save As          Save calculation with new name
File      Print               Print screen graphic
File      Settings       Configure graphic, printer, etc.
File      Exit                Program end

Edit Text Input draw. name, draw. no., text
Edit     Pre-Dimensioning  Determine required bolt size
Edit     Bolt Input bolt dimensions
Edit     Clamping Plates Input strained parts
Edit     Nut Input nut or bolt hole
Edit     Load Input forces
Edit     Friction Input friction coefficents
Edit Tightening Input assembly tool
Edit Temperature Input operating temperature
Edit     Ecc.Application Input data for eccentric load
Edit Flange Input flange dimensions and load (SR1+ only)
Edit Calc.Method Configure calc.method, friction input, preload
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View    Printout Output of results
View    Load-Extension Diagram Graphic display elevation
View Assembly Condition req. Load-extension diagram assembly required
View Assembly Condition Load-extension diagram assembly max/min
View    Working Condition req. Load-extension diagram Fvmin,req. with FA
View    Working Condition max Load-extension diagram Fvmax with FA
View    Working Condition min Load-extension diagram Fvmin with FA
View    Drawing Bolt joint drawing
View Table Drawing Drawing and tables with results
View Load Load-extension diagram and load valcues
View Flange Flange drawing with bolts (SR1+ only)
View M-alpha diagram Torque - tightening angle diagram
View F-alpha diagram Clamping load  tight.angle diagram
View FM-MA diagram Clamping load - tightening torque
View MA-FM Tightening torque  clamping load
View FM Statist. Statistical distribution of clamping load FM
View Diagrams All diagrams
View Material Material properties
View Error Messages Description of Error messages

CAD Projection  Bolt joint graphic
CAD Side View   Bolt joint graphic
CAD Top View            Bolt joint graphic
CAD Bottom View    Bolt joint graphic
CAD Bolt Drawing
CAD Nut Drawing
CAD Clamping Plates Drawing of all clamping plates
CAD Flange Flange Drawing (SR1+ only)
CAD Diagrams Select diagram to be exported

Database Thread             Modify or add thread data
Database Bolt head          Modify or add screw head dimensions
Database Material Bolt Bolt material base data, Re=f(T), E=f(T)
Database Material Plates,Nut Plate and nut material base data, Re=f(T), E=f(T)
Database Nut Nut types and dimensions
Database Tightening tool alpha A coefficient
Database Friction Friction head, thread, mating surface
Database Friction min/max Max/min friction head, thread, mating surface

Document Drawing data Drawing date, edited, checked, standard
Document Modifications-Info List of changes
Document Modifications-Printout Printing out the list of changes
Document Modification-New Append new changes
Document Edit previous modif. Edit previous change
Document Delete prev. modif. Delete last change
Document Document 1..5 Load external document and program
Document Setup Configure external programs and files

OLE Start Excel Execute MS-Excel, if installed on computer
OLE Export to Excel Copy input data to Excel worksheet
OLE Import from Excel  Load input data from Excel worksheet
OLE Printout to Excel Copy printout to MS-Excel worksheet

Help Auxiliary Image Show Auxiliary Images
Help Error Messages Show error messages
Help History Show alterations and additions to FED5
Help Demo Run Demo Mode
Help HEXAGON Homepage Display www.hexagon.de
Help E-Mail to HEXAGON Send E-Mail to HEXAGON
Help Licence            Display Licence Information

http://www.hexagon.de
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5.2. File
The SR1 Files are text files which contain all input data.

File - New
Guides you through all input windows. See following chapters for details.

File  Open
All created SR1 Files are listed. Select desired file with mouse or cursor keys. Then the file is opened by
SR1 and can be printed or modified and re-calculated. After loading a SR1 file, a calculation of the
geometrical values and mechanical strength properties is carried out. To erase a file, select it, then press
DEL key.

File - Open (Table)

Main properties of all fed files in the current folder are displayed in a table. You can sort to desired property
by right mouse click into title cell. By cursor keys or mouse click, file is opened and calculation results are
shown in Quick View.

File - Save
After entering the filename, a SR1 file with the current input data is created. All letters and numbers, as well
as the characters - & ( ) % $ # ! ' can be used. Upper and lower case letter can be used. Special characters
such as " , ; . : # ? = / > < " are not permitted. The filename may have up to 255 characters. The extension
input .SR1 is not absolutely necessary, as it is automatically added by the program.
If previously opened and modified, data are saved under the same name without asking for file name.

File - Save as
Save File under a new file name. See also File Save .

NULL File
If you save data to a file called "NULL", that file will be loaded automatically after program start. You can use
this option for storing your preferred material data and quality classes.

ACTUAL File
When you exit the program, the data is automatically saved to a file "ACTUAL". When restarting the
program, you can obtain the latest data by loading the ACTUAL file.
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5.3. Input/Edit

When inputting numeric values or text, usually a default value or text will appear in the input window. If you
wish to accept these defaults just confirm by OK or Enter key. If you later wish to alter individual values in
order to carry out optimization, all you do is go to input, confirm the correct values or enter new data as you
require. As soon as you begin to enter a new value, the default immediately disappears. If you wish to
append an existing text, then you first move the cursor one space to the left and then one space to the right.
By using the cursor keys you can change or edit the default values. The insert mode is switched on and off
with the <INS> key. By using the <DEL> key, you can delete individual characters.
The help button allows you to display the help texts. The help texts, which are in the file SR1.HLP, can be
altered and appended with your own texts (see chapter 9).
With the Windows version the help pictures appear in the background, in order to be able to see them, the
dialogue window must be moved down.

Databases
SR1 software includes many table values in the database (e.g. thread, bolt head, material, etc.). This
provides the optimum method for calling up standard or manufacturer specific data. Compared to manual
input of these values there is the advantage that you no longer have to look up the values in tables. In
addition, as the values are not a solid part of the program you can alter the data or add your own values.

The hi-lited bar is moved up and down with the cursor keys in order to choose the appropriate data record.
You then accept the data from the choosen record with the <ENTER> key or "OK" button. With <ESC> or
"Cancel" button you can leave the database without accepting any of the values for your calculation.



                                                                                                                                                                                                                                          --------
SR1 5-5

Indexed Database:
Wherever possible the databases are indexed. This allows the data records to be sorted and displayed
according to size.
The Thread Database has a double-index first on "TYP" (type) and then on nominal diameter "D". This
allows the contents to be displayed in according to diameter, first the metric threads (M) and then all fine
threads (N). If you wish to add data records to the database, these will be indexed and added to the
database in the appropriate place. Tool bar: You have the possibility to append the database with further
data records, or to alter the existing values to reflect company own values.
Edit: Simply write over the existing value in the data field with the new value.
Append: In order to append the database with further values just click into "+" button.
Empty fields will appear in the first line which you can fill-in. If the database is indexed, the new values will
automatically be moved to the correct place in the database.
Remove: If you choose "-" button, the data record on which the cursor is located will be marked for deleting.
If you then do not wish to delete the record, go to "-" again, the mark will then be removed. The marked
record will be physically deleted when you carry out "Pack".
Pack: With "Pack" the marked data record will be deleted from the database
First: Go to first data record.
Last: Go to last data record.
Search: This function is very useful for searching the whole database for a specific character string (e.g. "15
CrNi" in the material database). The hi-lited bar goes to the field with the character string. With "Search Next"
you can search for further character strings.
dBase Format: HEXAGON software uses the dBase format for its databases. This allows you to edit the
DBF files with dBase or other dBase compatible databases. In addition, you can also load company-own
specific data into HEXAGON software via dBase files.

5.3.1. Text Input

When outputting results to printer, three lines are reserved for designation, drawing number, name,
comments, etc. The first line includes the drawing name and number, the other two lines can be filled with
comments, names etc.
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5.3.2. Pre-Dimensioning

By inputting a few data, the required bolt size can be approached in steps with dimensioning. A combination
of three bolt sizes and strength classes are available.

The strength class from the choosen combination is used as the standard for the bolt input. This is not
possible with the bolt size as the thread has not yet been defined as metric normal or fine thread.

Specifications for dimensioning:
- Load
- static/dynamic
- Load from axial force concentric/eccentric or shearing force
- Amount of axial or shearing force
- Bolt strength class
- Tightening tool

The bolt load is significantly increased by the additional bending load with non-central force introduction.

Dimensioning must be relatively large in case of shearing force, as the residual screw clamping force must
prevent slipping of the clamping piece.

The scattering of assemble pre-gripping force is dependent on the tightening method.
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5.3.3 Bolt Input

In most cases you will work with shank bolts or waisted bolts in accordance with DIN. SR1, however, offers
the possibility of freely defining bolt geometry.

A database for selecting the thread will appear on screen when you select a shaft or waisted bolt.
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The cursor is positioned on  the thread size which was calculated in pre-dimensioning. You can choose the
required thread size from the database. The database can be altered or appended with additional thread
sizes (at "Database" menu).

The abbreviations have the following meanings:

 Sign     Meaning                                 Unit
 D        Rated Diameter of thread                mm
 P        Pitch                                   mm
 AS       Stress cross-section area               mm² 
D3       core diameter                           mm² 
TYP      thread type (M=metric  N=metr.fine)     "M","N"

Diameters d2, d3
The exact value for min. diameter d3 and flank diameter d2 depends on the allowance and tolerance grade.
You can enter d2 and d3, or SR1 calculates it for you according to allowance grade 4h and 6h (max. value)
The diameters d2 and d3 influence strength calculation (min. stress area) and torque (friction area and
radius).

Input Bolt Head

The bolt head is selected from the list. Each bolt head has a matching database file. The data for the
drawing and calculation are obtained from the matching database file (minimum head lining dw), which is to
be found under "Database->Screw Head".
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Usually, you don't need to worry about the bolt head database as it contains all DIN standard values.
However, if you wish to add additional thread sizes (e.g. M9), then you will also have to add the data for the
additional sizes to the bolt head database. The abbreviations for naming the data fields are explained in the
appropriate help pictures (see Appendix).

If you select a special head, then you must add the data for the appropriate thread diameter to the
"SONDKOPF" database. The calculation requires the thread length and minimum head seat diameter dw. A
special head is then drawn as a cylinder with the diameter d_head and the height h_head.

Bolt Length
After selecting a bolt head, you have to enter the shaft length (up to the head) for shaft and waisted bolts.
You can select the shaft length from the database "LSCHRAUBE.DBF" by entering 0. You can adapt the
database to internal company own required steps of the bolt length. If the clamping piece has already been
entered, the program will suggest an appropriate bolt length.
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Strength Class

The bolts are divided into strength classes and listed according to tensile strength and yield point. The first
value shows the approximate tensile strength, the yield point can be calculated from both values.

Example for 10.9:
Tensile Strength : 1000 N/mm²
Yield Point : 900 N/mm²

Fatigue Strength
You can SR1 let calculate fatigue strength to one of the two formulas in VDI 2230, or you can enter the
Sigma a perm. value for the bolt, or you can select it from a (appendable) database (MAT_B_SA.DBF).
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Special Bolts
As well as shaft and waisted bolts, you can freely define any number of stepped bolts by entering the part-
cylinder.

If you first choose a waisted bolt in accordance with DIN, then exit the input, after that go to input for special
bolts, you will see how the individual bolt steps are defined. First the bolt head of the part-cylinder is entered
followed by length, diameter and inner diameter (for hollow bolts).

After all part-cylinders have been defined, don't forget to enter thread, head and bolt material. By entering
and deleting individual part-cylinders you can easily make changes and optimize the bolt.
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5.3.4. Input Clamping Plates

SR1 allows you to define up to 10 clamping pieces held by the bolt. Enter length, outer diameter and drill-
hole diameter of the clamping pieces. If the clamping piece is not cylindrical, enter the equivalent diameter. If
the clamping piece is a large plate, simply enter a very large diameter. SR1 will calculate a substitute
diameter when calculating the elastic compliance.

Material data can be selected from database "pressung.dbf" or "mat_p_1.dbf", or you enter material name,
permissible pressure, yield point, temperature extension coefficient and modulus of elasticity.

SR1 calculates elasticity delta from E module, cross-section an length of clamping plate. If clamping plate is
a spring or spring washer, you can check "Input elasticity" and enter elasticity (delta = 1 / spring rate R)
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Washer Database
By entering 0 for the length of the clamping piece, the database with the file "KLEMMSTK.DBF" will be called
up. Select a washer from the database. Thickness as well as inner and outer diameters will be taken directly
from the table. You can append the database with parts you use a lot and distancing sleeves.

Clamping Piece Material Database
The material for the individual clamping pieces is selected from the "PRESSUNG" database. During
calculation all seam lines will be checked that the permissible surface pressure is not exceeded. Should the
material you require not be in the database, then you can add it (see the beginning of this chapter).
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5.3.5 Edit Nut

The nut thread can be a dead-end hole or a nut.

Dead-end Hole
With a dead-end hole you must also enter thread depth and drill depth. The dead-end hole joint will be
shown as a cutout in the CAD drawing. The pull-out stability is calculated according to the DOSE formulas,
see auxiliary picture. For this reason nut thread material must be choosed. A calculation of pull-out stability
should be carried out for dead-end holes with shallow depth and nuts of soft materials.
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Nut
The most common DIN nuts are listed in a database. Please note that a data record must exist for the
entered thread size.

The required nut is selected with the cursor keys and accepted with the ENTER key.
Under the menu item "special" the nut is simply defined by entering the head contact surface (for surface
pressure calculation) and the height.

Nut Material
If you use bolt and nut material in an equivalent strength class, there is no need to calculate the nut. In this
case there is no danger of stripping the nut thread. If you use different material for bolt and nut, the safety
against stripping of the nut thread must be calculated

SR1  Prevailing-Torque Type Nuts
If you use nuts with prevailing torque, additional torque by friction and additional shear stress has
to be considered in this case. SR1 calculates higher tightening torque and reduced clamp load for
equivalent stress. If you select a prevailing-torque type nut from database, friction torque
(TORQUE) is set as MA pre, and MA pre option will be set. If you later use a standard nut without
prevailing-torque, you have to reset MA pre to 0.
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5.3.6. Edit Load

The load is made up of the following:
- upper and lower tension force FAo and Fau
- Location of the force introduction of FA
- Shearing Force FQ
- Residual clamping force FKR

Axial Force FA
SR1 calculates the vibration stress for dynamic load between the forces FAo and FAu. For static load is
FAu=FAo, for alternating load is FAu=-FAo, and for dynamic pulsating load the lower value is FAu = 0.

Axial Preload FA pre
Compared with FA, the statical preload FApre is applies already at the assembly procedure (i.e. clevis joint).
FA pre is added to Fao and Fau, and also increases the assemly torque MA (MA pre = FApre * dkm/2 * µK).
Locations of force introduction for Fapre are assumed to be the same than for axial load FA.

Administrator
标注
这里  1
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Force Introduction
The effect of the attacking force FA is highly influenced by the location of the force introduction. Use of a
distancing sleeve under the bolt head greatly reduces the effect of the additional bolt force FSA. The force
introduction factor is n = 1 for force introduction at the bolt head and force reduction at the nut thread. The
force introduction factors nE for the upper clamping piece and nA for the lower clamping piece are entered
separately in the program. No factor is required for force introduction on the bolt head or nut.
The force introduction factor n is the ratio of the length L1 to the whole length of the clamping piece LK.

Load-extension diagram for different force introduction heights (see also VDI 2230).

Shearing Force FQ
When entering the residual clamping force you should take into account whether or not a shearing force FQ
attacks the clamping plates.

Residual Clamping Force F KR
The residual clamping force between the fixed plates must be at least FK req. = FQ / µTr for attack of
shearing force. The residual clamping force must be greater than the clearing force for eccentric load.

Settling Amount
Leveling off of surface unevenness on a bolt causes appearance of settling, which means the assembly
tension must be reduced by Fz. SR1 makes suggestions for the settling amount according to the VDI 2230 of
1986, Bauer & Schaurte Vademecum, and VDI 2230 draft of 1998.

Preload F pre, FA pre and MA
Preload F pre, FA pre and MA pre are not defined in VDI 2230. It must be activated at Edit->Calculation
Method.

Preload Fpre and FApre
Fpre is the bolt preload required to bend plates that does not contribute to clamp load.
FKmin is reduced by the value of Fpre, and FMmax,req is increased by the value of Fpre.
Set Fpre=0 for standard joints to VDI 2230.
FApre is similar than Fpre, but FApre raises tightening torque (by FApre/µK). Load introduction of FA pre is
like defined for FA. Load introduction of Fpre is between screw head and nut thread.

Prevailing Torque MApre
For self-locking screws and self-tapping screws you can define torque MApre caused by thread friction.
MApre increases tightening torque MA, but on the other side it also reduces maximum tightening torque
because of higher torsion stress.
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5.3.7. Input Friction

The friction values for the head seat and thread are required in order to calculate the tightening moment. The
friction between the seam areas is required for the calculation of the necessary residual clamping force with
shearing forces.

The friction coefficients for the most important pairs can be selected from the database delivered with the
program. The database values can be modified and appended as required.

With newer versions of SR1 (V11.0) you can enter maximum friction values. SR1 calculates minimum torque
MAmin from alphaA and friction tolerance. By entering Sigma coefficient, SR1+ calculates Gaussian
distribution of FM and reject rate from statistically added tolerances.

If you use prevailing torque bolts or nuts, enter the prevailing torque at MApre.

At Edit->Calculation Method , you can set input of min. Friction coefficients or min/max.
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5.3.8. Tightening Method

The tolerance between minimum and maximum pre-stress force depends upon the selected tightening
method choosen from the database.

This database can of course be appended as required. The abbreviations have the following meanings:

 sign         meaning
 ALFA_A       tightening factor alphaA
 dev_per_c    deviation +/- percent 
ANZ_METHOD   tightening method

 EINST_METH   setting method
 BEMERK       remark

The tightening factor and scattering are related directly to each other, the program uses only the tightening
factor alphaA. Scattering has been included in the database as this value generally has more meaning. The
values can be converted with the following formula:

                     2  alphaA
  deviation [%] = (                  - 1 ) * 100
                     1 + alphaA

               100% + deviation[%]
  alphaA    =                      
               100% - deviation[%]

Instead of alphaA, you can input FMmin, MAmin, or MA tolerance.
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Reduction coefficient torsion k tau
When tightening the bolted joint, the bolt is stressed with tension and torque from thread friction as well. After
tightening, a rest of torque remains. VDI 2230 recommends to calculate with 50%. Reduction coefficient
depends on the tightening method. For hydraulic tightening with pressure to the clamping plates you can get
tau k=0, the best case.

Reference stress Sigma red,B = (sigma²z + 3( k

 
* max )² )0.5

Yield Point Factor and Tightening Torque
How strongly the bolt needs to be tightened can be defined from the tightening torque MA or the yield point
factor nüRp. A yield point factor of 1 means that the bolt is tightened until the tightening tension has reached
the yield point. Usually a value of 0.9 is used for torque controlled tightening tools. SR1 calculates and
displays the marginal torque at which the yield point is reached when you enter the tightening torque. Usually
one tries to reach the point where the bolt is tightened to a maximum (approx. 90% of the yield point). Should
such a high clamping force not be required or the surface pressure becomes too great then check whether or
not a cheaper bolt with lower strength, or the next smaller size would be suitable for the application before
you reduce the tightening moment or yield point factor.

Alternatively, you can enter the tightening torque MA or the assembly prestressing force FM, then SR1
calculates the yield point factor.

Calculation Base
The VDI2230 draft of 1998 uses another equation for tightening torque, this results in a higher value for MA.

Bolt/Nut driven
For nut-driven joints, SR1 uses the friction diameter between last plate and nut. The friction coeffient µK
means the friction between nut and last plate for this case.
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5.3.9. Eccentric Load Introduction

The non-central tension of a bolt joint causes, in addition to the longitudinal deformation, also a bending
deformation of the clamped pieces, which also cause additional longitudinal deformation. Several additional
entries are required when calculating with eccentrics.

Whereas when calculating with concentric load it is sufficient to enter an equivalent diameter for the cross-
section of the clamping piece, with eccentric load the exact measurements are required, namely:
1. Geometry of the seam area
2. Geometry of the bending body

In the most simple case, the cross-section of the seam area and the bending body is identical. In the most
difficult case, the bending body has several steps so that a substitute bending body must be used in order to
calculate the cross-section and surface moment of inertia.

The eccentricity s is obtained from the position of the centre of gravity of the bending body in relation to bolt
axis. The centre of gravity axis is also the datum axis for the input of the distance in relation to force effect
line a and rim distance u and v. The eccentricity s is negative when the force effect line and bolt axis are on
opposite sides of the centre of gravity axis.

AD is the seam area surface of the bending body minus the surface of the through-hole for the bolt (A BT - A
H). Entering 0 is only correct for cylindrical, non-stepped clamping pieces.
I BT is the moment of inertia of the seam area surface which is to be calculated for the individual geometry.
By entering 0 the surface moment of inertia of a hollow cylinder with the cross-section AD will be suggested
for use.

IBers is the substitute moment of inertia which should be selected for stepped bending bodies. IBers is the
same as the moment of inertia IB from the surface of the bending body AB for cross-sections which remain
the same. The program suggests the moment of inertia of a cylinder with the cross-section AD for
calculation.

íBers is the substitute moment of inertia with drilling. By entering 0 the moment of inertia will be calculated as
the difference between IBers minus the drilling moment of inertia.

When more than two clamping pieces are defined, you will be asked between which two pieces the bending
body calculation should be carried out.
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5.3.10. Temperature

The clamping force will increase or decrease at working temperature, if you use different materials for bolt
and clamping plates. The length difference is calculated with:

delta L = L * alpha

The temperature coefficient alpha is loaded from the material databases MAT_BOLT (bolt) and PRESSUNG
(clamping plates). The reference temperature (room temperature) was international standardized to 20øC
and should never be changed. Yield point and e modulus of materials are temperature-dependent as well,
data are loaded from following data bases:

MAT_B_RE.DBF: yield point of bolt, dependent from temperature in °C

MAT_B_E.DBF: E module of bolt, dependent from temperature in °C

MAT_P_E.DBF: E module of plates, dependent from temperature in °C
If no E-modulus was found in the database (E=0), SR1 uses an approximate calculation:

      E20 - T * 72.5          E20 = E-Module at 20°C
E =                          T   = Temperature in °C
     E20 - 20 * 72.5

If no database values are available for the warm yield point, SR1 uses another approximation formula:

Re = Re20 * (1.018 - T/1120)

Re20 = yield point at 20°C
T    = temperature in °C

If no database values are available, SR1 generates a warning.
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A temperature calculation page is added to the printout, if reference temperature and working temperature
differ.

      ----------------------------------------------------------------------
      Room temperature                  T0       °C                20
      ----------------------------------------------------------------------
      Working temperature               T        °C               300
      ----------------------------------------------------------------------
      Length change, screw              delta LS mm             0.515
      ----------------------------------------------------------------------
      Elasticity modulus, screw         ES       N/mm²         206000
      ----------------------------------------------------------------------
      Elasticity modulus, screw 300     ES300    N/mm²         185000
      ----------------------------------------------------------------------

      CLAMPING PIECE (T = 300°C)
      ----------------------------------------------------------------------
      i    l20 [mm]  l300 mm   E N/mm²   E 300     d20 mm/N    d300 mm/N
      ----------------------------------------------------------------------
       1     60.000    60.193  210000    185000    0.218E-6    0.247E-6
      ----------------------------------------------------------------------
       2     50.000    50.364   44000     23008    0.601E-6    1.150E-6
      ----------------------------------------------------------------------
       3     50.000    50.126  125000    104462    0.212E-6    0.253E-6
      ----------------------------------------------------------------------

      Length change, clamping piece     delta LP mm             0.683
      ----------------------------------------------------------------------
      Elast.compliance, screw           delta St mm/N        2.464E-6
      ----------------------------------------------------------------------
      Elast.compliance, plate           delta Pt mm/N        1.65E-6
      ----------------------------------------------------------------------
      Yield point, screw                Re       N/mm²            940
      ----------------------------------------------------------------------
      Yield point, screw 300øC          Re300    N/mm²            705
      ----------------------------------------------------------------------
      Clamping force loss, work.temp.   delta FM N             -40831
      ----------------------------------------------------------------------
      Mounting pre-stress force 300øC   FM 300   N             290196
      ----------------------------------------------------------------------
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5.4. Output

The calculation results can be printed out as text or displayed on screen, in addition it is possible to display
or printout a hardcopy of the load-extension diagram of the calculated bolt joint as a graphic.

5.4.1. Printout
All input and calculated data can be displayed on screen, printed out or saved to file. The printout design
(separating line *** or ==== ) can be configured under Edit->Settings->Printout.

Output to Printer
The printer interface (LPT1 thru 4) can be configured (see Chapter 4). The configured printer type is
irrelevant for text output. The printer character set should be configured for PC so that special language
characters and special signs can be printed out. For printers with manual individual page loading, the
printout can be stopped after each page (pause after each page).

Output to File
The output can be diverted to file, if for example no printer is currently free or installed. A file name must be
entered (e.g. SR1.OUT). The file will then be stored in the SR1 directory.

Printout Description

        ====================================================================»
       º                                                                    º
       º    SR1 V4.6  calc. of bolted joints to VDI 2230           page  1  º
       º                                                                    º
       º    R S TECHNOLOGIES  Farmington Hills                              º
       º                                                                    º
       º    User: TRAIN         File: 1E                        11/10/1996  º
       º                                                                    º
       Ì====================================================================¹
       º                                                                    º
       º    bolted joint in a hydraulic cylinder                            º
       º    application example 1                                           º
       º    from VDI 2230                                                   º
       º                                                                    º
       È====================================================================¼

       BOLT:  DIN 912 - M12 x  60 - 10.9
       ======================================================================
       i   de [mm]   di [mm]   l [mm]    A [mm²]     x[mm]     delta [mm/N]
       ======================================================================
        1    12.0       0.0      30.0      113.1      30.0     1.288E-6
       ----------------------------------------------------------------------
       G3     9.9       0.0      12.0       76.2      42.0     0.764E-6
       ----------------------------------------------------------------------

The bolt part-cylinders are numbered with the index i. The index G3 characterises the part-cylinder with the
non-screwed in thread part of the bolt. The entered diameter and lengths are da, di and l. A stands for the
cross-section of the part-cylinder. The core cross-section Ad3 is relevant for the calculation of the elastic
compliance in the thread free part G3. x is a consecutive coordinate for the end of the respective part-
cylinder, commencing with x=0 at the bolt head. ë stands for the elastic compliance of the part-cylinder, this
is in proportion to the screw extension.

       ----------------------------------------------------------------------
       rated diameter of thread          M        mm             12.00
       ----------------------------------------------------------------------
       thread pitch                      P        mm              1.75

 ----------------------------------------------------------------------
       stress cross-section              As       mm             84.30
       ----------------------------------------------------------------------
       diameter to As                    ds       mm             10.36
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----------------------------------------------------------------------
       core diameter                     d3       mm              9.85 

----------------------------------------------------------------------
       edge diameter                     d2       mm             10.87

 ----------------------------------------------------------------------
       minimum outside diameter          d0       mm             10.36
       ----------------------------------------------------------------------
       minimum cross-section             A0       mm²            84.30
       ----------------------------------------------------------------------
       yield point                       Rp0,2    N/mm²            940
       ----------------------------------------------------------------------
       max. tensile stress (at FM)       Sigma 0  N/mm²            680
       ----------------------------------------------------------------------
       Young`s modulus                   ES       N/mm²         206000
       ----------------------------------------------------------------------
       bolt length up to head            l        mm             60.00
       ----------------------------------------------------------------------
       thread length                     lG       mm             30.00
       ----------------------------------------------------------------------
       head diameter                     DK       mm             18.00
       ----------------------------------------------------------------------
       min. dia. of head seat            dw       mm             17.23
       ----------------------------------------------------------------------
       grip of bolt                      lk       mm             42.00
       ----------------------------------------------------------------------
       equivalent length                 lequ     mm             33.82
       ----------------------------------------------------------------------

The index 0 of the smallest outer diameter and its cross-section is necessary for the calculation of the
greatest occuring tensile stress. For DIN shaft bolts this is the stress cross-section, for special bolts this can
also be the smallest diameter of the part-cylinder.

The clamping length lK is the total height of the clamped piece. l ers is the substitute length for a bolt with
thread along its whole length with the same elastic compliance as the bolt used. The substitute length is
necessary for eccentric load.

CLAMPING COMPONENTS (DIMENSIONS)

       ======================================================================
        i   de [mm]   di [mm]   l [mm]  x [mm]    A equ[mm²]  d equ[mm]
       ======================================================================
        1     80.0      13.5      42.0    42.0      525.1       29.2
       ----------------------------------------------------------------------

       CLAMPING COMPONENTS (MATERIAL AND LOAD)
       ======================================================================
        i  material           E [N/mm²]   p zul      p max     delta [mm/N]
       ======================================================================
        1  C 45                  210000    700       636      0.38E-6
       ----------------------------------------------------------------------

da, di and l are the entered diameter and lengths. x is the consecutive coordiante for the end of the clamping
piece from the bolt head.
A ers is decisive cross-section for the calculation of the elastic compliance. For large "da" the cross-section
used to calculate the elastic compliance is composed of a substitute pressure part with the diameter "ders".

Material, E modulus and p adm. are values from the material database.

A maximum occuring surface pressure in relation to the next clamping piece, head or nut seat is calculated
for each clamping piece. The greatest surface pressure value in relation to the neighbouring piece is output.
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delta is the elastic compliance of the clamping piece.

       BOLTED JOINT: termin. bolted joint
       ======================================================================
       thread depth                      tG       mm             20.0
       ----------------------------------------------------------------------
       bore depth                        t        mm             25.0
       ----------------------------------------------------------------------

       ELASTICITY
       ======================================================================
       Elasticity bolt sect.             delta is mm/N        1.288E-6
       ----------------------------------------------------------------------
       Elasticity free thread            delta G3 mm/N        0.764E-6
       ----------------------------------------------------------------------
       Elasticity head                   delta K  mm/N        0.206E-6
       ----------------------------------------------------------------------
       Elasticity thread                 delta G  mm/N        0.382E-6
       ----------------------------------------------------------------------
       Elasticity nut                    delta M  mm/N        0.206E-6
       ----------------------------------------------------------------------
       Elasticity screw                  delta S  mm/N        2.846E-6
       ----------------------------------------------------------------------
       Elasticity plates                 delta P  mm/N        0.38E-6
       ----------------------------------------------------------------------

       SPRING RATE
       ======================================================================
       Spring rate screw                 R S      N/mm        351.4E3
       ----------------------------------------------------------------------
       Spring rate plates                R P      N/mm        2.625E6
       ----------------------------------------------------------------------

       ELONGATION
       ======================================================================
       Elongation screw                  fSM      mm          0.16
       ----------------------------------------------------------------------
       Shortening plates                 fPM      mm          0.0215
       ----------------------------------------------------------------------

       FLEXURAL ELASTICITY
       ======================================================================
       bolt grip ratio                   lk/d                     3.50
       ----------------------------------------------------------------------
       flexural elasticity screw         beta S   1/Nmm       0.355E-6
       ----------------------------------------------------------------------

The elastic compliance deltaS of the bolt is the sum of part-cylinder compliance, with the addition of the bolt
head, thread and nut compliance.

The elastic compliance deltaP of the plate is the sum of the compliance of all clamping pieces. The elastic
bending compliance ßS of the bolt is necessary with eccentric load.

 LOAD
       ======================================================================
       max. tensile force                FAo      N              24900
       ----------------------------------------------------------------------
       min. tensile force                FAu      N                  0
       ----------------------------------------------------------------------
       shearing force                    FQ       N                  0
       ----------------------------------------------------------------------
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       reqd. residual clamping force     FKR      N               1000
       ----------------------------------------------------------------------
       min. residual clamping force      FKmin    N               9672
       ----------------------------------------------------------------------
       theor.prestressing force for Rp0.2FM-Rp    N              62670
       ----------------------------------------------------------------------
       assembly prestress. force         FM       N              56403
       ----------------------------------------------------------------------
       max.req.assembly prestress. force FMmax    N              42527
       ----------------------------------------------------------------------
       min.req.assembly prestress. force FMmin    N              26579
       ----------------------------------------------------------------------
       total amount of settling          fz       mm           0.00504
       ----------------------------------------------------------------------
       prestress.force loss thr.settling Fz       N               1561
       ----------------------------------------------------------------------
       req.prestressing force            Fv       N              25018
       ----------------------------------------------------------------------
       min.prestressing force            Fv min   N              33691
       ----------------------------------------------------------------------
       max.prestressing force            Fv max   N              54842
       ----------------------------------------------------------------------
       suppl. bolt force from FA         FSAo     N              881.9
       ----------------------------------------------------------------------
       suppl. plate force from FA        FPAo     N              24018
       ----------------------------------------------------------------------

For an explanation of the calculated forces please see under Load Extension Diagram.

       DISTRIBUTION OF FORCE
       ======================================================================
       introduction of force: to the clamping piece 1
       ----------------------------------------------------------------------
       force distribution factor         n1                      0.30
       ----------------------------------------------------------------------
       share of elastic.on introd.force  delta1               0.267E-6
       ----------------------------------------------------------------------

       ----------------------------------------------------------------------
       application of force: at the nut thread
       ----------------------------------------------------------------------

       ----------------------------------------------------------------------
       force ratio                       phi K                   0.118
       ----------------------------------------------------------------------
       force ratio                       phi n                   0.035
       ----------------------------------------------------------------------
       force distribution factor         n                       0.30
       ----------------------------------------------------------------------

Force distribution factor and force ratio are calculated from the locations of the force introduction and the
elastic compliance of the bolt and clamping pieces.

 VIBRATORY STRESS
       ======================================================================
       perm.vibr.stress f.heat-tr.bolt   sigma A  N/mm²       +/-     50
       ----------------------------------------------------------------------
       vibratory stress of bolt (concen.)sigma a  N/mm²       +/-      6
       ----------------------------------------------------------------------
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Permanent breakage when sigmaa becomes greater than sigmaA !

FRICTION
       ======================================================================
       coeff.of friction in thread       µG                      0.140
       ----------------------------------------------------------------------
       coeff.of friction in head seat    µK                      0.100
       ----------------------------------------------------------------------
       coeff.of friction in mould seam   µTr                     0.120
       ----------------------------------------------------------------------

       ASSEMBLY
       ======================================================================
       tightening procedure: torque controlled by torque wrench
       ----------------------------------------------------------------------
       setting procedure:
       ----------------------------------------------------------------------
       yield point tightening factor     nue Rp                   0.90
       ----------------------------------------------------------------------
       tightening factor                 alpha A                  1.60
       ----------------------------------------------------------------------
       dispersion of assembly force               %               23.1
       ----------------------------------------------------------------------
       tightening torque screw           MA       Nm             110.2
       ----------------------------------------------------------------------
       tightening torque f yield point   MA Rp    Nm             122.5
       ----------------------------------------------------------------------
       tightening angle                  alpha M  deg            37.44
       ----------------------------------------------------------------------

MA is the tightening torque representing a tensile stress in the bolt which is 90% (nue Rp) of the yield point.

 FACTORS OF SAFETY
       ======================================================================
       safety against loosening          FM/FMmax                1.33
       ----------------------------------------------------------------------
       safety against overelongation     Rp/sig.0                1.38
       ----------------------------------------------------------------------
       safety ag.fract. (stat.)          Rp*A0/(Fvmax+FSA)       1.42
       ----------------------------------------------------------------------
       safety ag.fatigue fract.(concen.) sigmaaperm/sigmaa               8.69
       ----------------------------------------------------------------------
       safety plate surface pressure     pperm/p                 1.10
       ----------------------------------------------------------------------

All Safety factors must be higher than 1.0 !
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5.4.2. Load Extension Diagrams

Load extension diagrams can be graphically displayed on screen. It is also possible to output to CAD or desk
top publishing via DXF or IGES files. With the supplementary software DXFPLOT, you can output scale
graphics and drawings to plotter or laser printer.

All forces and extensions from the calculation are shown in the load extension diagram.

FV is the necessary pre-stress force calculated from the residual clamping force and tensile force.
Fmmin,req and Fmmax,req are the calculated necessary assembly forces. The actual maximum assembly
force is FM. FM-Re is the theoretical assembly force in case the bolt is to be tightened up to its yield point.

FMmin,req is the lowest necessary assembly pre-stress force and results from the sum of the necessary pre-
stress forces FV and the settling force loss FZ. FMmax,req results from the tolerance due to scattering from
the tightening method.

With the keys "+" and "-" you can enlarge or scale down the diagram, or zoom window by left mouse key.
You can move the diagram in all four directions with the cursor keys. The right mouse button will return you
to the original diagram. A copy of the diagram can be printed out with "File-Print".
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Load Extension Diagram (Assembly Condition)

These diagrams shows the forces in assembled unloaded state.
FM,max is the assembly force which occurs when the bolt is tightened a tension of 90% of the yield point
(Factor nue).
FZ is the settling force loss which results from evening of the surface irregularities.
FVmin and FVmax are the smallest and greatest pre-stress forces affecting the bolt.
FV is the required pre-stress force which is dependent on the amount of the attacking tensile force, the force
introduction factor and the necessary residual clamping force.

Load Extension Diagram in Working Condition
The diagram shows clearly how the influencing tensile force FA affects the joint. For dimensioning, the
external axial force FA is used together with the necessary pre-stress force FV or otherwise with the
maximum and minimum occurring pre-stress force Fvmax and FVmin. This diagram shows only the forces
which occur in connection with the load on the bolt joint due to the axial force FA.

FV is the necessary pre-stress force which is dependent on the at external tensile force FA, the force
introduction factor n and the required residual clamping force FKR.
The additional bolt force FSA is dependent on the size of the axial force FA and factor n resulting from the
force introduction positions. It is the part of the axial force FA with which the bolt is additional loaded.
The additional plate force FPA results as the difference between the axial force FA and the additional bolt
force FSA. It is the part of the axial force FA which removes the load from the clamping pieces.
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5.4.3. M-alpha Diagram

The M-alpha diagram shows the tightening torque as function of the bolt assembly angle (Proj.from elastic
origin).  MA is the torque according to the entered values. MA Rp is the Torque until yield point of the bolt,
and MA Rm until tensile strength. Also there are marked the torque without head friction (MG), and the
theoretical torque MA Rp (µ=0)  without friction. Yield zone and tolerance zone (friction and alphaA) are
hatched at the diagram.

F-alpha-Diagram
The F-alpha diagram shows the assembly prestressing force FM as function of the bolt assembly angle
(Proj.from elastic origin).
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5.4.4. FM-MA-Diagram

The FM-MA diagram shows the dependency of the pre-stressing force from the tightening torque. FM-Rp µ0
is the theoretical line without friction. FM is the pre-stressing force according to the entered nü Rp, FM-Rp at
yield point, and FM-Rm at tensile strength of the bolt.

5.4.5. FM Statist.
This chart shows the statistical distribution of the clamping load FM. It depends on FM,min and FM,max and
the Sigma coefficient entered at Edit->Tightening .
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5.4.6. View Material
Here you can list the material data included in the databases mat_bolt.dbf, pressung.dbf and mat_p_1.dbf.
Temperature-dependent curves of yield point Re and modulus of elasticity E are drawn only if data available
from databases mat_b_re.dbf, mat_b_e.dbf, mat_p_re.dbf, mat_p_e.dbf.
Click into buttons < and > to show previous/next record and OK to return to menu.

View Drawing

You can have a diagram of the calculated bolt displayed. Under "CAD" you can have the file exported to
CAD via the DXF or IGES files.
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View Load
Load-Extension diagram and tables with load data and formulas, sorted for input data, required load and real
load.
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5.5. CAD

The calculated bolt joint can be created as a drawing via DXF or IGES files, output to screen is also possible.
The drawing files can then be loaded, edited, plotted or included in construction and combination drawings
with CAD systems which have the appropriate interface.

When you choose to create DXF or IGES files the file swill be stored in the SR1 directory if no other CAD
directory has been configured (see Chapter 4: Configuration). We recommend that you first display the
drawing on screen to see if it is in order. When outputting as a CAD file you have to give the file a name
(without the ending DXF or IGS)

You can display a front or side elevation, however the only difference is in the bolt head and the nut. The top
elevation shows the bolt head, the bottom elevation shows the nut.

Top elevation bolt joint Bottom elevation bolt joing
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Table Drawing
The drawing contains tables with the most essential data and results of the bolted joint.
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5.6. Database

Most of the data for for input, calculation and drawing of the bolt joint is taken from the database delivered
with the program. You can alter individual data fields or append with new data records, e.g. for a thread M15.

The SR1 database fields will be explained shortly.

For database input, please also read the explanations on pages 5-4 and 5.5.

5.6.1. Thread Database

The abbreviations have the following meanings:

=================================================================
  sign      meaning                                  unit
=================================================================
  D         nominal diameter of thread               mm
-----------------------------------------------------------------
  P         pitch                                    mm
-----------------------------------------------------------------
  AS        stress cross-section of thread           mm²
-----------------------------------------------------------------
  D3        core diameter                            mm²
-----------------------------------------------------------------
  TYP       thread type(M=metric N=metr.fine)        "M","N"
-----------------------------------------------------------------
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5.6.2. Bolt Head Database
The most common bolt head shapes are available in the SR1 database. The field descriptions are stored in
the matching help pictures.

Database for Hexagon Socket Head Screw

Database for Hexagon Head Bolt Heads

Database for Slotted Countersunk Screws (DIN 963)
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Database for Slotted Raised Countersunk Screws (DIN 964)

Database for Slotted Cheese Head Screw (DIN 84)

Database for Slotted Cheese Head Screw (DIN 85)
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Database for self-defined head

Database for Hex Flange Screw
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5.6.3. Database Material (for clamping plates)

=================================================================
  Sign        Meaning                                Unit
=================================================================
  MATERIAL    Material name
-----------------------------------------------------------------
  RE          Yield point                            N/mm²
-----------------------------------------------------------------
  RM          Tensile strength                       N/mm²
-----------------------------------------------------------------
  P_PERM      Ultimate pressure                      N/mm²
-----------------------------------------------------------------
  BETA_B      shear factor (0.577 for steel)
-----------------------------------------------------------------
  E_MODUL     Modulus of elasticity                  N/mm²
-----------------------------------------------------------------
  ALPHA_T     Temperature coefficient                mm/K
-----------------------------------------------------------------

Temperature-dependancy of E-Modulus
The MAT_P_RE database is linked with PRESSUNG.DBF via the MATERIAL field. Therefore, MATERIAL
name in the two databases must be exactly the same.

=================================================================
  Sign        Meaning                                Unit
=================================================================
  MATERIAL    Material name
-----------------------------------------------------------------
  E20         E module at 20=C                       N/mm²
-----------------------------------------------------------------
  E100        E module at 100=C                      N/mm²
-----------------------------------------------------------------
  E200        E module at 200=C                      N/mm²
-----------------------------------------------------------------
  E300        E module at 300=C                      N/mm²
-----------------------------------------------------------------
  E400        E module at 400=C                      N/mm²
-----------------------------------------------------------------
  E500        E module at 500=C                      N/mm²
-----------------------------------------------------------------
  E600        E module at 600=C                      N/mm²
-----------------------------------------------------------------
  E700        E module at 700=C                      N/mm²
-----------------------------------------------------------------
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5.6.4. Database Nut

The Database structure for hexagon nuts to DIN 934 and to DIN 6915 are identical.

Hexagon Flange Nut
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5.6.5. Database tightening tool

=================================================================
  Sign          Meaning
=================================================================
  ALFA_A        Tightening factor alpha a
-----------------------------------------------------------------
  DEV_PER_C     Dispersion of assembly force
-----------------------------------------------------------------
  TIGHT_METH    Tightening method
-----------------------------------------------------------------
  ADJ_METHOD    Adjustment method
-----------------------------------------------------------------
  INFO          Remarks
-----------------------------------------------------------------

The tightening factor and scattering are related directly to each other, the program uses only the tightening
factor alphaA. Scattering has been included in the database as this value generally has more meaning. The
values can be converted with the following formula:

-----------------------------------------------
                      2  alphaA
   dispers. [%] = ( ---------  - 1 ) * 100
                      1 + alphaA
-----------------------------------------------
-----------------------------------------------
                100% + dispers.[%]
   alphaA    =    ----------------------
                100% - dispers.[%]
-----------------------------------------------
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5.6.6. Database Friction

Thread friction
=================================================================
  Sign          Meaning
=================================================================
  MUE_G         Friction coefficient thread
-----------------------------------------------------------------
  SCREW         Material/Surface of screw
-----------------------------------------------------------------
  GREASE        Lubrication for bolted joint
-----------------------------------------------------------------
  NUT           Material/Surface of Nut thread
-----------------------------------------------------------------

Screw head friction:
=================================================================
  Sign          Meaning
=================================================================
  MUE_K         Friction coefficient for srew head
-----------------------------------------------------------------
  SCREW         Material/Surface of screw
-----------------------------------------------------------------
  GREASE        Lubrication of bolted joint
-----------------------------------------------------------------
  COMPONENT     Material of the 1st clamping plate
-----------------------------------------------------------------

Friction in the Mould Seam:
=================================================================
  Sign          Meaning
=================================================================
  MUE_TR        Mould seam friction
-----------------------------------------------------------------
  KLEMMST_1     Material of clamping plate 1
-----------------------------------------------------------------
  SCHMIERUNG    Lubrication of the bolted joint ?
-----------------------------------------------------------------
  KLEMMST_2     Material of clamping plate 2
-----------------------------------------------------------------
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5.6.7. Database Washers/clamping plates
You can acces this database from the clamping plates input window.

=================================================================
  Sign          Meaning
=================================================================
  NAME          Info to washer or clamping plate
-----------------------------------------------------------------
  DI            Bore diameter
-----------------------------------------------------------------
  DE            Outside diameter
-----------------------------------------------------------------
  S             thickness of washer/clamping plate
-----------------------------------------------------------------
  INFO          Additional information
-----------------------------------------------------------------

5.6.8. Database Bolt length
When clicking < at bolt length input, SR1 gets a suitable value from the database

=================================================================¸
  Sign          Meaning
=================================================================µ
  L             Bolt length in mm
-----------------------------------------------------------------´
  INFO1         remarks
-----------------------------------------------------------------´
  INFO2         remarks
-----------------------------------------------------------------Ù
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5.6.9. Database Bolt Material

MAT_B_RE and MAT_B_E are linked to MAT_BOLT via KLASSE field. Therefore, the text string in the
KLASSE fields must be exactly the same.

MAT_BOLT.DBF - Basic data of bolt materials.
=================================================================
  Sign        Meaning                                Unit
=================================================================
  KLASSE      Material or material class
-----------------------------------------------------------------
  RE          Yield point                            N/mm²
-----------------------------------------------------------------
  RM          Tensile strength                       N/mm²
-----------------------------------------------------------------
  BETA_B      shear coefficient (0.577 for steel)
-----------------------------------------------------------------
  E_MODUL     Modulus of elasticity                  N/mm²
-----------------------------------------------------------------
  ALPHA_T     Temperature coefficient                mm/K
-----------------------------------------------------------------

MAT_B_RE.DBF - Dependancy of the yield point from working temperature.
=================================================================
  Sign        Meaning                                Unit
=================================================================
  CLASS       Material class, material name
-----------------------------------------------------------------
  T_MAX       max. working temperature                °C
-----------------------------------------------------------------
  RE20        yield point at 20=C                    N/mm²
-----------------------------------------------------------------
  RE100       yield point at 100=C                   N/mm²
-----------------------------------------------------------------
  RE200       yield point at 200=C                   N/mm²
-----------------------------------------------------------------
  RE300       yield point at 300=C                   N/mm²
-----------------------------------------------------------------
  RE400       yield point at 400=C                   N/mm²
-----------------------------------------------------------------
  RE500       yield point at 500=C                   N/mm²
-----------------------------------------------------------------
  RE600       yield point at 600=C                   N/mm²
-----------------------------------------------------------------
  RE700       yield point at 700=C                   N/mm²
-----------------------------------------------------------------
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Databases Bolt Material

MAT_B_E.DBF
Modulus of elasticity, dependant from temperature. If values are 0, SR1 uses an approximation
formula.
=================================================================
  Sign        Meaning                                Unit
=================================================================
  KLASSE      Material name, class
-----------------------------------------------------------------
  E20         E module at 20=C                       N/mm²
-----------------------------------------------------------------
  E100        E module at 100=C                      N/mm²
-----------------------------------------------------------------
  E200        E module at 200=C                      N/mm²
-----------------------------------------------------------------
  E300        E module at 300=C                      N/mm²
-----------------------------------------------------------------
  E400        E module at 400=C                      N/mm²
-----------------------------------------------------------------
  E500        E module at 500=C                      N/mm²
-----------------------------------------------------------------
  E600        E module at 600=C                      N/mm²
-----------------------------------------------------------------
  E700        E module at 700=C                      N/mm²
-----------------------------------------------------------------

MAT_B_SA.DBF
Fatigue Strength Sigma A (alternating tension), dependent from thread size.

=================================================================
  Sign        Meaning                                  Unit
=================================================================
  IDENT       Material, Production method
-----------------------------------------------------------------
  D_1         Sigma A for thread size 1 mm           N/mm²
-----------------------------------------------------------------
  D_4         Sigma A for thread  M4                 N/mm²
-----------------------------------------------------------------
  D_6         Sigma A for thread  M6                 N/mm²
-----------------------------------------------------------------
  D_10        Sigma A for thread  M10                N/mm²
-----------------------------------------------------------------
  D_16        Sigma A for thread  M16                N/mm²
-----------------------------------------------------------------
  D_25        Sigma A for thread  M25                N/mm²
-----------------------------------------------------------------
  D_40        Sigma A for thread  M40                N/mm²
-----------------------------------------------------------------
  D_63        Sigma A for thread  M63                N/mm²
-----------------------------------------------------------------
  D_100       Sigma A for thread  M100               N/mm²
-----------------------------------------------------------------
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5.7. Help

Auxiliary picture

Under this menu reference point you can obtain auxiliary screen drawings for the input of spring dimensions.
The auxiliary illustrations are drawings in the plot Hewlett Packard HP/GL format. This means that you can
complete them with your own graphics. You can design your own drawings via CAD or DTP and send the
output to an HP-Plotter or to a file. In which case you will have to configure the HP7475 as plotter; the
filename extension is PLT. The drawing size should be 160 x 120 mm, as these values are used as the
drawing margin.

Error messages

If error messages occur, you can obtain explanation and help for each error message. The text is stored in
the file SR1.ERR.

Quit
SR1 is ended at File->Exit. Before the program is quit the current data is automatically written to the File
ACTUAL.SR1.




